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Curso de  AutoCAD 2002   - Módulo 2D 

§ Apresentação:  
 O AutoCAD é um programa de CADD (Computer Aided Draft and Design - Desenho e Projeto 
Auxiliado por Computador -  ou somente CAD). A AutoDesk Inc. apresentou a Versão 1.0 do 
AutoCAD na COMDEX em Las Vegas em novembro de 1982.  Por sua arquitetura aberta, torna-se 
um ambiente ideal para o desenvolvimento de aplicativos por terceiros, permitindo a utilização em 
praticamente qualquer área de desenho e projeto, tanto como engenharia, arquitetura, agrimensura, 
indústria, científico, design ou qualquer outra aplicação que necessite de desenho e projeto auxiliado 
por computador. 

1. Equipamentos necessários: 
 Para utilizar o AutoCAD 2000, é recomendada a configuração mínima abaixo: 

§ Computador PC baseado em processador Pentium 133 MHz 
§ Sistema Operacional Windows 95, Windows 98 ou Windows NT 
§ 32 MB de memória RAM 
§ Placa de Vídeo de 800x600 com 64 mil cores e Monitor colorido 
§ Unidade de CD-ROM 
§ Dispositivo Apontador 

2. Um pouco de história: 
 O que é CAD (Desenho e Projeto Auxiliado por Computador)? O desenho e projeto auxiliado 
por computador tiveram início com a indústria aeroespacial e automobilística, nos fins da década de 
60. Até então, os projetos eram limitados a desenhos manuais, sujeitos a imprecisão humana. Com a 
evolução dos computadores, sistemas complexos de CAD eram desenvolvidos, mas limitados às 
grandes empresas. Com o advento dos computadores PCs, uma revolução teve início, basicamente 
pelo baixo custo dos equipamentos, e muitas opções de programas. Um destes programas é o 
AutoCAD, criado pela AutoDesk Inc., nos EUA. Inicialmente o programa era destinado a desenhos 
mecânico. Devido a sua arquitetura aberta, logo se tornou um padrão para desenvolvedores de 
sistemas, contando hoje com milhares de desenvolvedores por todo o mundo. Outros sistemas de 
CADD também se firmaram como padrão, como o Micro-Station e o Vector Works. 
 
 Sistemas de CAD (projeto e desenho), CAM (Manufatura), CAE (Engenharia), GIS 
(Geoprocessamento) específicos tem sido criados, destinados à mecânica, agrimensura, engenharia, 
arquitetura, topografia, estradas, modelagem, tais como o AutoCAD, AutoSurf, AutoArchitect, 
AutoBuilding, Cad Overlay,  Catia, GisPlus, EMS e Hiteck. 

3. Evolução das versões do AutoCad: 
 Desde o seu lançamento em 1982, o AutoCAD tem passado por diversas revisões e alterações, 
melhorando os recursos do programa, sendo: 
-Versão 1.0 R.1 (11/1982) 
-Versão 1.2 R.2 (04/1983) 
-Versão 1.3 R.3 (08/1983) 
-Versão 1.4 R.4 (10/1983) 
-Versão 2.0 R.5 (10/1984)  
-Versão 2.1 R.6 (05/1985) 

-Versão 2.5 R.7 (07/1986) 
-Versão 2.6 R.8 (04/1987) 
-Release 9  (09/1987) 
-Release 10 (07/1988)  
-Release 11 (10/1990) 
-Release 12 (06/1992) 

-Release 13 (11/1994) 
-Release 14 (02/1997) 
-R-2000  (02/1999) 
-R-2002  (02/2001) 
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4. Compatibilidade de arquivos: 
Todas as novas versões do AutoCAD, são compatíveis com os arquivos de versões anteriores, 

mas não vice-versa. Isto é o AutoCAD 2002 lê os arquivos das versões anteriores, mas as anteriores 
não podem ler os arquivos do AutoCAD 2002. O AutoCAD 2002 lê e converte os arquivos da versão 
12, 13, 14 e 2000 para a versão R2002 e pode exportar os arquivos com formato da versão 12, 13 e 
14 como arquivos do tipo DWG ou DXF. 

Os arquivos do AutoCAD 2002 são compatíveis com o AutoCAD 2000 e vise-versa (na 
realidade são os mesmos tipo de arquivos). 

5. Carregando o AutoCad: 

 Ligue o computador, e dentro do Windows, escolha no menu INICIAR a opção PROGRAMAS 
e depois a opção AutoCAD 2002 e depois o ícone  do programa (também está escrito AutoCAD 
2002), e dê um click com o botão esquerdo do mouse, iniciando o programa (também se pode utilizar 
o atalho que está sobre a Área de Trabalho). 
 Aparecerá o quadro Today  onde você poderá escolhe se abre um desenho existente, cria um 
novo ou utiliza uma biblioteca de símbolos. Também permite acessar a Internet junto com o 
AutoCAD. 

 
Dependendo da configuração, também poderá utilizar o quadro Start Up solicitando que você 

utilize uma ajuda para inicializar um rascunho (Scratch), ou começar por um protótipo (Template), 
novo desenho (Wizard), ou ainda abrir um desenho existente (Open). 
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6. Dentro do programa AutoCad 2000 
 
Quando já carregado, o 

AutoCAD 2000 apresenta a tela 
semelhante a representada ao lado. 
 Esta tela contém vários itens que 
merecem ser estudados individualmente. 
 A tela visível é chamada de tela 
gráfica, onde se visualiza várias 
informações. Um cursor em forma de 
duas linhas perpendiculares (x-hair) 
indica o ponto de inserção das entidades 
que serão desenhadas. 
 
 
 
 

E várias outras partes do programa a seguir: 
§ Barra de Titulo: 

 Nesta barra aparece o nome do programa e o nome do desenho em edição. 
 
§ Barra de Menus Pull-down: 

 Nesta barra aparece o nome dos principais grupos de menus. 
 
§ Barra de Menu de ícones padrão (Standard Toolbar): 

 Nesta barra encontra-se os ícones de comandos mais utilizados, sendo: New, Open, Save, 
Print, Print Previw, Spelling, Cut to Clipboard, Copy to Clipboard , Paste from Clipboard, Match 
Properties, Undo, Redo,  Launch Brownser, Oject Snap, UCS, Inquiry, Redraw, Aerial View, 
Named View, Pan Realtime, Zoom Realtime, Zoomt, Zoom Previous e Help. 
 
§ Barra de Menu de Propriedade de Objetos: 

 Esta barra permite visualizar e executar principais mudanças em entidades e ambiente de 
trabalho durante a edição, sendo: Make Object’s Layer Current, Layers, 
Layer Control, Color Control, Linetype, Linetype Control, Line Weight 
Control e Plot Style 
 
§ Menus em cascata: 
 Nos itens de menu que tiveram uma seta à direita, tem-se a opção de 
abrir em menus tipo cascata, bastando para isso acompanhar o mouse sobre o 
texto, e quando o item desejado estiver destacado, click com o botão 
esquerdo do mouse para executar o comando. Neste tipo de comandos não é 
necessário completar outros tipos de alternativas para a sua execução. 
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§ Menu de quadro de 
diálogo: 

Nos itens de menu que 
tiverem uma reticência à 
direita, tem-se a opção 
de abrir quadros de 
diálogos, bastando para 
isso acompanhar o 
mouse sobre o texto, e 
quando o item desejado 
estiver destacado, click 
com o botão esquerdo 
do mouse para chamar o 
quadro. Estes quadros devem ser preenchidos em sua grande variedade de opções para que a 
execução do comando seja realizada. 

 
§ menu de tela (screen menu) 

Este é o maior e mais completo menu do AutoCAD. Ele permite uma 
compatibilidade de menus com as versões antigas do programa.  Para deixa-lo visível vá 
à opção: Tools → Preferences → Display → Display window parameters 
 

Tem-se ao topo deste menu a palavra AutoCAD. Quando se seleciona um item 
neste menu, pode-se abrir outro menu com itens relacionado ao anterior ou respostas 
possíveis ao comando acessado por este menu. Muitas vezes utilizndo o menu pull-down, 
o menu de tela também será acessado para o comando especificado. 

Este menu pode ser posicionado em qualquer canto da tela gráfica. 
 

§ Linha de comando 

 Onde são visualizados e editados os comandos chama-se tela gráfica. Uma área de Prompt na 
parte inferior do programa permite a visualização da digitação dos comandos e as respostas aos 
comandos feitos pelo AutoCAD. Para alternar entre a tela gráfica e a tela de texto pressione a tecla 
F2.  
§ barra de status  

Abaixo da linha de comando, encontra-se a  barra de status, onde se visualiza as coordenadas, 
snap mode, grid display, ortho mode, polar tracking, object snap, object osnap tracking, show/hide 
lineweight e model/paperspace 

7. Teclas de funções no AutoCad: 
 Algumas teclas de funções têm uso específico no AutoCAD, sendo: 
F1 No Windows esta tecla é de Ajuda (help). 
F2 Alterna-se entre  a tela gráfica e tela de texto. 
F3 Pemite o acesso ao quadro de diálogo Osnap Settings. 
F4 Permite o acesso do cursor ao menu pull-down e sobre a área de digitalização quando se 

utiliza uma mesa digitalizadora. 
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F5 Alterna entre os planos isométricos. 
F6 Liga e desliga o contador de coordenadas, tendo ainda três posições: 
 -coordenadas absolutas, onde são mostrados apenas as coordenadas X e Y do cursor. 
 -coordenadas relativas, onde são mostrados as coordenadas polares do cursor em relação a 

último ponto marcado na tela, isto é, indica a partir deste ponto, uma distância e um ângulo até 
o cursor. 

 -desligado,  último ponto do cursor na tela 
F7 Liga e desliga o GRID, que são pontos visíveis na tela, utilizados apenas para a referência no 

desenho. 
F8 Liga e desliga o ORTHO, que permite somente o desenho de linhas ortogonais ao cursor 

X-hair. 
F9 Liga e desliga o SNAP, que funciona como um tipo de imã - não permite manter o cursor fora 

do snap. 
F10 Liga e desliga a opção de POLAR, que permite que sejam desenhadas linhas dentro de outros 

eixos, além do ortogonal. 
F11 Liga e desliga o OBJECT SNAP TRACKING, que permite uma busca acelerada do objeto 

snap. 

8. Conceitos sobre a área gráfica: 
 Para entender melhor o ambiente de desenho do AutoCAD, deve-se entender alguns conceitos 
básicos utilizados no programa (e praticamente em todos os tipos de programas de CAD). 
§ GRID:  São pontos visíveis na tela, utilizados apenas para a referência no desenho. Os 

grids podem ser alterados de aspecto, podendo ter valores de espaçamentos diferentes, tanto no 
X, como no Y. Liga e desliga com a tecla F7 ou pela Barra de Status. 

§ SNAP:  É uma espécie de malha, que não permite que o cursor ande fora dela. Funciona 
como um tipo de imã, prendendo o cursor à esta malha. É muito útil para um desenho com 
precisão e velocidade. Liga e desliga com a tecla F9 ou pela Barra de Status. 

§ UNIDADE DE TRABALHO: No AutoCAD a unidade de trabalho é admensional, isto é, 
definida pelo usuário, não existe unidade fixa, pode ser, centímetros, metros, polegadas, milhas, 
ano-luz, etc. Ajusta-se com a opção de menu  Format→ units. 

§ LIMITE DO DESENHO: Devido ao fato de não ter uma unidade de trabalho fixa, o limite 
do desenho, também não é fixo, portanto é praticamente infinito. Ajusta-se com a opção de menu  
Format→drawing limits. 

§ ZOOM: A tela gráfica é apenas uma pequena janela que se movimenta sobre o desenho. 
Pode-se coloca-la sobre qualquer parte dele, com qualquer incremento de visualização. Pode-se 
desenhar com precisão um prédio com uma cidade ou estado em torno dele, ou mesmo desenhar 
uma bactéria na cozinha deste mesmo prédio. 

9. Introdução ao editor gráfico: 

Menu File:    
 New  É apresentado  o quadro Create New Drawing. Inicia um novo 

desenho a partir de um desenho template já configurado (normalmente é o 
desenho acad.dwt), ou permite a escolha de outro desenho template, onde já está 
definido o tipo de letras, layers, blocos, tipos de linhas, dimensionamento, etc.. 
Outra opção, é começar pelo Wizard, que lhe permite configurar alguns 
parâmetros do desenho e no final é inserido um formato vazio. 

 Open  Abre um desenho já existente. 
 Save  Salva a edição corrente. Se não foi dado um nome ao desenho, 
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o AutoCAD lhe pedirá um nome. 
Save As Salva um desenho sem nome em um arquivo ou renomeia o desenho corrente 

(também permite gravar o seu desenho como template .dwt). 
Export Permite exportar arquivos para outros programas CAD. O formato de arquivo mais 

comum em CAD é o DXF (Arquivo de Intercâmbio de Desenho), por exemplo, pode-se exportar os 
seus desenhos em arquivos no formato DXF para serem utilizados por um programa de cálculo de 
estrutura ou um programa artístico vetorial como o Corel Draw. 

Print Setup Abre o quadro de configuração Preferences na opção Pinter. 
Print Preview Mostra como o desenho será visto quando impresso ou plotado. 

 Print (ou plot) Envia o desenho para que seja impresso em uma impressora gráfica, plotter, 
ou que seja gravado em um arquivo de plotagem para ser levado a um bureal de serviço. Também  
permite gerar arquivos em formato .dwf para utilização em páginas de Internet. A opção de impressão 
será detalhada mais adiante. 

Drawing Utilities →→  Audit / Recover  Verifica ou Recupera um arquivo de desenho 
danificado. Normalmente um erro no desenho do AutoCAD pode ocorrer durante a leitura ou escrita 
no disco Winchester ou diskette. 

Drawing Utilities →→  Purge Permite eliminar do desenho, elementos de blocos, tipos de 
linhas, layers, estilo de dimensionamento, de letras que não estão sendo mais utilizados pelo 
desenho. 

Send  Envia o desenho corrente para o correio eletrônico (e-mail). 
Exit  Permite sair do AutoCAD. Se a edição ainda não foi salva, o programa lhe 

perguntará se ela deverá ser salva. 

Menu Edit:   
 Localiza-se neste menu os recursos de edição do Windows, como 
desfazer (undo), refazer (redo), recortar (cut), copiar (copy) e colar (paste). 
O comando Copy que permite a inserção de objetos da área de transferência 
do Windows, ou outros tipos de formatos de dados. O comando Copy Link e 
Paste Special permite utilizar a tecnologia OLE (object linking and 
embedding) do Windows, inserindo partes de arquivos de outros programas. 
O comando Clear, é o comando eraser do AutoCAD. OLE Links permite 
atualizar, modificar e cancelar links OLE existente. Find permite encontrar um 
texto no desenho e se necessário subistituí-lo por outro. 
 

Menu e Toolbar draw: 

 

 Line Desenha linhas simples. Desenha uma linha de um ponto a outro, e aguarda mais um outro 
ponto para continuar desenhado linhas. Finaliza-se o comando com Enter ou ESC. Para desenhar 
linhas com medidas exatas, utilize o Snap ligado ou entre com os dados através de algum processo de 
entrada de dados. (Entrada de dados: veja mais adiante). 
 Ray Desenha uma linha com início e sem fim. Permite criar linhas de construção para o 
auxilio do desenho. 

 Construction Line (xline) É uma linha infinita. Permite criar linhas de construção para o 
auxilio do desenho. 

 Multiline  Desenha linas multiplas e paralelas, com grandes recusos de edição. 
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3D Polylines Desenha polilinhas no espaço 3D. 

 Polyline Desenha linhas contíguas. Também permite o desenho de arcos dentro do mesmo 
comando. É muito utilizado também para achar uma área, bastando desenhar um polígono e pedir a 
sua área com o comando Area.  

 Poligon Desenha poligonos, que são polilinhas fechadas, definidas pelo lado, inscrito em 
um círculo ou circunscrito por um círculo. 

      P2
                 raio do poligono
      P1

poligono inscrito  

P2
           altura do centro

              P1      do poligono

poligono circuscrito  

P2

     P1

Poligono definido pelo lado

lado do
poligono

 
 Retangle Desenha um retângulo. Pede apenas dois pontos em diagonal na tela. 
 Circle   Desenha círculos pelo centro e raio; centro e diâmetro; 2 pontos; 3 pontos; duas 

tangente e raio e três tangentes. 

 Donut Desenha circulos com espessuras de linha. (que são na realidade duas polylines). 
 Spline Cria curvas spline quadratica ou cubica através de matemática nurbs (nurbs: 

nonuniform rational B-spline curve). 
 

 Arc  Desenha arcos. Deve-se sempre considerar o sentido anti-horário para o desenho 
dos arcos. Este comando desenha arcos por: 

P1=C

P3=E

P2=S
arco definido por
center/start/end

180

sentido do arco
= anti-horário

270

90

0

arco definido por
três pontos

P1

P2

P3

arco definido por
start/center/end

P2=C P1=S

P3=E

arco definido por
center/start/angle

P1=C

45° ângulo

P2=S

P3=A

arco definido por
center/start/length

P1=C
L=corda

P2=S

L

P3=L

ângulo

P2=E

P1=S

arco definido por
start/end/angle

45° 45°
P3=A

arco definido por
start/end/radius

P3=R P1=S

drag=R P2=E

arco definido por
start/center/angle

P2=C

45°

P1=S

ângulo

P3=A

arco definido por
start/end/dir

P1=S

P2=E
direção da
tangente

90°

P3=T

arco definido por
start/center/length

P2=C

P3=L

L=corda
P1=S

L

 
 

Arc Continue Continua a desenhar arcos a partir do último arco desenhado. 
 Elipse Desenha elipses pelo centro e eixos ou  pelo centro 

e dois eixos. Também desenha um arco de ellipse. 
 Block Veja mais adiante na seção de Blocos. 

 eixo

 eixo
 centro  

raio

p1 p2

centro e raio centro e diametro dois pontos

diametro

p1 p2 p2p1

diametro

p1 p2

p2

três pontos tan/tan/raio tan/tan/tan

t1

t2

R

t1

t2

t3



 Unicentro Izabela Hendrix da Igreja Metodista 
Curso de Arquitetura e Urbanismo - Disciplina de Informática Aplicada à Arquitetura 

 
 

 

9 

 Point  Desenha um ponto utilizado para dividir linhas e arcos em dimensões iguais. Para 
mudar o estilo do ponto apresentado na tela, deve-se altera o comando Point 
Style: menu Format→Point Style; e depois no prompt command digite: 
Regen (ou menu View→Regen). Isto forçará um redesenho da tela, 
permitindo ver os pontos desenhados. 

 Text  Veja mais adiante na seção sobre Textos. 
Surface Cria objetos 3D a partir de entidades Polifaces ou 3Dface. 

 Hatch Preenche uma área com um padrão de Hachura. Estes 
padrões podem ser de dois tipos: definido pelo usuário, que se consiste em 
linhas paralelas ou em uma malha quadrada; ou padrões armazenados, que 
são tipos complexos de hachura. O processo de seleção das entidades pode 
variar de simples seleção, ou por pesquisa de fronteiras do espaço a ser 
hachurado. Também se pode adicionar ou remover o espaço seleciondo. 

Solid  Desenha uma área fechada com 3 ou 4 lados preenchida com uma cor. 
-Fill on  preenchimento ligado 
-Fill off preenchimento desligado 
Atenção no sentido de construção do sólido. Veja no desenho acima. 
Dica: Utilizar o comando Solid para simular mesas sobre pisos hachurado, 

utilizando em conjunto os comandos elevation e o hide. 
 Boundary Cria o objeto Region a partir de objetos existente (utilizado para 3D). 

Menu e Toolbar Modify: 
 

 
 Está agrupado neste item do menu os comandos de construção, isto é, 
comandos que constroem uma nova entidade a partir de uma já existente, ex.: 
comando copy (diferente dos comandos do grupo MODIFY que apenas modificam 
as entidades, ex.: comando move). 

 Erase Apaga uma entidade ou um grupo de entidades selecionadas.  
 

 Copy  Copia uma entidade ou um 
grupo de entidades selecionadas de um ponto 
base para um ponto final. A opção multiplus 
permite a cópia do mesmo objeto várias 
vezes. 
 
 
 

1 2 1 2

 

P1

ponto de base ponto final

P2
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 Mirror Espelha uma entidade ou um grupo de entidades 

selecionadas por uma linha de espelho definida por dois pontos. A 
distâcia dos objetos a linha de espelho são iguais. O comando 
pergunta se mantém ou apaga o objeto original. 
 

 
 

 Offset Faz a cópia para o lado (offset) de 
linhas, polilinhas, arcos e círculos. O comando 
inicialmente pergunta pela distância do offset. 

 
 Array Gera 

um arranjo com uma 
entidade ou um grupo de 
entidades selecionadas. 
Tendo como opção o 
array retangular, onde as 

entidades se alinham em torno de colunas e linhas, ou o array polar, onde as entidades se organizam 
em torno de um eixo. O array polar ainda pode ser rotacionado ou não rotacionado.   
  

 Move Altera a localização das entidades selecionadas. 
Para a execução do comando, selecione um grupo de entidades, 
dê um pick para o ponto início do movimento e um pick para o 
fim do movimento. 

 Rotate Rotaciona uma entidade ou um grupo de 
entidades em torno de um ponto base. O comando tem a opção reference que permite a mudança da 
referência (o ângulo default é zero). 

x

ponto de base

seleção

45°

   rotate com reference

seleçãox

3

2

1

 
 A opção reference permite pegar uma nova referência para a rotação das entidades (já que o 
valor default é 0), permitindo utilizar um dos lados conhecido da entidade. 
  1-2- pega-se a referência no ângulo conhecido 

3- leva-se ao novo ponto destino 
 Scale  Modifica a escala de uma entidade ou um grupo 

de entidades selecionadas. O valor de escala maior que 1 
aumenta, e menor que 1 diminui. O comando pede um ponto de 
base para a partir dele executar a ação. (Apenas alguns objetos 
quando desenhados sofrerão escala, como Blocos de Simbologia 
e Formatos. Veja na mais adiante em Blocos). 

 Stretch Estica as entidades selecionadas. Só 
podem ser utilizados os modos de seleção crossing e 
window (também WC e CP) para este comando. (Este 
comando também existe dentro da opção de edção por 
Grips. Veja mais adiante). 

 Lengthen Modifica o comprimetro do objeto selecionado (Utilize a opção dynamic). 

P1

ponto de base ponto final

P2

 

P1

P2 linha de
espelho

original cópia

seleçãoseleção

lado do
picklado do

pick
distânciadistância

42

2
1

x

ponto de base

seleção

scale=2

        P1

                        P2
      x              x                           B1=ponto de base
    B1           B2                        B2=ponto final

180°
não rotacionado

(5 cópias)

180°
rotacionado
(5 cópias)

array polar

≡≡ (3)
rows(linhas)

colunas      (5)
array retangular
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 Trim  Corta linhas, polilinhas e arcos em relação a uma outra entidade (fronteira). As 
fronteiras devem estar cruzando as entidades. 
 1° - Seleciona-se as fronteiras 
 2° - Seleciona-se as entidades a serem cortadas  
 dica: pode-se selecionar tudo como fronteira e depois ir cortando o que é desejado 

←não pode ser cortado

↑ segmentos cortados,
   pick no lado a ser cortado

fronteirax
x
x

x

 
 Extend Extende uma linha, polilinha ou arco em direção a uma outra entidade (fronteira). 

As fronteiras devem estar no alcance das entidades. 
 1° - Seleciona-se as fronteiras 
 2° - Seleciona-se as entidades a serm extendidas 

  
↑seleção na metade mais
  próxima da fronteira

←fronteira

←não pode ser extendido
x
x
x
x obs.: a fronteira tem que

estar dentro do diâmetro
do arco.

seleção na metade mais
próxima da fronteira

fronteira

x

 
 Break Quebra linhas, polilinhas, círculo ou arco em um ou dois pontos. 

  

xxx

S=1=2

S=1

2S 1

x

2xx selecionando objeto e o 2° ponto

selecionando apenas 1 ponto

selecionando objeto e 2 pontos

 
 Obs.: Se utilizar o comando break pelo teclado, será a opção objeto e 2° ponto. 
 

 Chanfer Semelhante ao fillet, faz a união das pontas de duas linhas, polilinhas ou arcos. 
Também permite fazer a concordância de linhas através de um chanfro, com as distâncias definidas 
pelo comando. 

   
D=0

x S2S1
x

pontas
apagadas

D2=2
D1=1

2

1

x S2S1
x

 
 Fillet  Faz a união das pontas de duas linhas, polilinhas ou arcos. Também permite 

fazer a concordância de linhas através de um arco, com raio definido pelo comando.    
 Explode Explode (desagrupa) as entidades como: blocos, polilinhas, hatch, 

dimensionamento, malhas e sólidos. Não se deve explodir dimensionamento (cotas). Pode existir no 
desenho blocos aninhados, isto é, blocos criados com outros blocos. Para explodi-los será 
necessário explodi-lo várias vezes, inicialmente o bloco principal, depois os outros demais blocos 
internos.  

Outros comandos de edição: 
 U  Desfaz os comandos executados, um por vez. Cuidado com este comando, pois uma 

vez feito o recuo na edição não pode mais ser desfeito. 
 Undo  Desfaz os comandos quantas vezes desejadas, até chegar no início da abertura da 
edição. Permite criar uma marca tipo “memória”. 

 Redo  Refaz apenas o último comando U ou Undo. 
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Select Prepara um grupo de entidades que fica aguardando a ação de um comando. Pode-
se utilizar para este comando qualquer modo de seleção dentro dele. (Pega-se o grupo de seleção 
feito com o comando select, utilizando a opção previous  dentro de um comando qualquer). 

 Properties  Faz mudanças diversas sobre as entidades selecionadas, como: cor, layer, 
thickness, elevation, posição. (veja o Menu Tools). 

10. Criação e edição de textos: 
 Mtext Permite escrever 

com a opção de texto múltiplo. 
Pede-se dois pontos na tela abrindo 
uma caixa de texto. Após isto, 
apresentará o quadro de diálogo ao 
lado, podendo modificar várias 
características da fonte. 

 Dtext  Comando de texto dinâmico. Normalmente utilizado para escrever somente uma 
linha de texto no desenho, como nome de comodos, numeração de portas e janelas, etc. Quando se 
escreve, tudo aparece na tela. A seqüência do comando é a seguinte: 
 - Ponto inicial do texto, 
 - Pede-se a altura do texto (somente se o estilo de letra tiver altura = 0 - Veja text style), 
 - Ângulo de rotação, 
 - Escreve-se o texto, 
 - Com enter finaliza-se o comando. 
Tanto o comado Mtext como o Dtext permitem modificar a justificativa do texto. 
 
Considere o esquema ao lado: 
LT, TC, TR, ML, MC, MR, BL, BC, BR São  opções de 
variações de justificativas baseadas no desenho ao lado. 
 
O comando Dtext ainda tem mais as seguintes opções de 
prompt: 
Style Opção do comando dtext que permite escolher o estilo de letra que será utilizado.  
Default Escreve o texto alinhado pela esquerda. 
Right Escreve o texto alinhado pela direita. 
Align Escreve o texto alinhado por dois pontos, mantendo as proporções originais da letra. 
Fit Escreve o texto alinhado por dois pontos, mas preenchendo o espaço entre estes 

pontos, mantendo altura original da letra e deformando a largura (width). 
Center Escreve o texto centralizado. 
Middle Escreve o texto centralizado horizontal e verticalmente. 
 
Mirrtext Variável que controla o 
espelhamento do texto através do comando 
Mirror. Normalmente utiliza-se a variável 
mirrtext = 0. 
 
Fontes O AutoCAD permite a utilização das fontes do Windows (fontes fft) e também uma série 
de fontes especiais para símbolos. O AutoCAD utiliza fontes especiais que são as fontes shx. Utilize 
estas fontes em seu desenho, pois são mais rápidas para o computador. As principais fontes SHX são 
as fontes Simplex e Romans. 
 
 

 
brbl bc

c

m

mc

rl

trtl tc

mrml
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Definindo uma fonte:  Para definir uma fonte 
nova, segue-se a seguinte seqüência abaixo: 
§ Vá ao menu Format→ Text Style;  
§ Cria-se um novo estilo com a opção New. 
§ Escolhe a fonte, podendo ser qualquer fonte 

SHX ou TTF do Windows,  
§ Defina uma altura (height) para a fonte. 

Caso contrário, se a altura for = 0, o 
comando dtext sempre pedirá a altura da 
letra, 

§ Define o espelhamento (backward). Permite 
que as letras sejam escritas de modo espelhado - só a letra, não o texto, 

§ Define se será de cabeça para baixo (upside-down), 
§ Define se será Escrita na vertical (vertical), 
§ Define a largura (width factor) para a fonte.Valores > 1 aumenta a largura da letra e < 1 diminui a 

largura da letra, 
§ Define o ângulo de inclinação (obliquing angle). Este ângulo configura uma aparência itálica para 

a fonte. Fontes que já são itálicas não necessitam desta mudança, 
§ Aplica-se e fecha o quadro de diálogo e o estilo será o corrente. 
 
Caracteres especiais: 

Pode-se escrever com as fontes TTF, utilizando os acentos de maneira natural. Para manter 
compatibilidade com as versões anteriores, ainda utiliza os seguintes símbolos: 
 %%C = ∅  símbolo de diâmetro 
 %%D = °  símbolo de grau 
 %%U = texto  sublinhado 
 %%O = texto  sobrelinhado 
 %%P  = ±  símbolo de tolerância 
 Outros caracteres podem ser escritos, bastando para isto entrar com o seu código ASCII. Ex.: 
para escrever a letra “A” maiúscula é o mesmo que digitar “Alt + 65”. 
 
Regra para altura de letras: 
 Um dos maiores problemas quando se trabalha com o AutoCAD em um sistema não 
padronizado, é as alturas de letras em relação a escala que se deseja desenhar.  Uma simples regra 
permite calcular a altura da letra no comando Dtext em qualquer escala. 
 

 Considerando as altura padrões em Pontos e de régua de normógrafo, temos: 
 

ALTURA  ALTURA  RÉGUA 
Pontos (Cm) 

 RÉGUA 
pontos (Cm) 

CL-60 5 0.15  CL-200 14 0.50 
CL-80 6 0.20  CL-240 17 0.60 
CL-100 7 0.25  CL-290 20 0.70 
CL-120 8 0.30  CL-350 24 0.80 
CL-140 10 0.35  CL-425 28 1.00 
CL-175 12 0.40  CL-500 34 1.20 
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Tem-se a seguinte fórmula, para cálculo de alturas de letra em qualquer escala: 

H DTEXT = H REGUA ∗∗ ESCALA

se a unidade do desenho for centimetros:

  

H REGUA ∗∗ ESCALA
se a unidade do desenho for metros:

H DTEXT =
10

 Obs.: o item ESCALA, é o denominador da escala de trabalho. 
 Ex.: Calcular a altura da letra no comando dtext para a régua  CL-140 para desenhar em uma 
escala de desenho de 1/250, considerando que a unidade do desenho é centímetros. 
 H = 0.35 ∗ 250  
 H = 87.5  unidades de desenho 

11. Menu tools: 

No menu TOOLS localiza-se vários comandos de configuração do ambiente de trabalho. 
Spelling   É o corretor ortográfico do AutoCAD. 
Quick Select Permite utilizar filtros para seleção de objetos 
Display Order Permite modificar as ordem que os objetos são apresentados na tela e 
consequentimente, como será impresso. 
Inquiry Permite ter informações sobre as entidades desenhas, sobre o desenho ou sobre os 
sistema de variáveis do AutoCAD. 
Properties  Faz mudanças diversas sobre as entidades selecionadas, como: cor, layer, 
thickness, elevation, posição. (veja o quadro de diálogo ao lado). 
AutoCAD Desing Center Permite um total controle dos desenhos existentes e o desenho que esta 
sendo editado, como pegar blocos, layers, textstyle, contido em um desenho que esta no disco rígido 
e inseri-lo no desenho que esta sendo editado. 
Load Aplication Carrega programas externos (Lisp, ADS e ARX) dentro do AutoCAD, criando 
novos comandos. 
Run Script  Permite carregar Script (que são seqüência de comandos gravados em forma de 
texto ASCII) para execução de seqüências de comandos. 
Macro  Carrega macros em Visual Basic, criando assim novos comandos ou automatizando 
tarefas dentro do AutoCAD. 
AutoLISP  Inicializa o programa Visual Lisp para criação ou edição de programas em LISP. 
Display Image Visualizar imagens Raster dentro do AutoCAD. 
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Named, Ortographics, Move e New UCS Comandos para recursos 3D. 
Wizards  Auxilios para configuração de Plotters e Layouts do desenho. 
 

Drafting Settings: Permite uma completa 
configuração do ambiente do desenho, sendo: 
 

Snap e Grid: 
- Snap Limita o movimento do cursor X-hair a uma 
malha invisível. Os valores podem ser alterados 
diferentemente tanto no X, como no Y, para trabalho com 
precisão. Por exemplo em arquitetura utiliza-se 
normalmente o snap = 5. 
-Grid Cria pontos de referência na tela, não sendo 
necessário que o seu valor acompanhe os valores do 
snap. Caso o grid tenha valor = 0, ele assumirá valor 
igual ao do snap. Tanto o grid quanto o snap podem ter 
valores diferentes no X e no Y. 
-Isometric  Transforma o cursor X-hair par os 
planos isométricos, sendo utilizado para desenho de 
perspectivas isométricas. Ex.: utilizando os comandos 
line e ellipse para o desenho isométrico pode-se 
construir o desenho ao lado. 
-Polar Snap Liga o snap para trabalha com 
distância e ângulos pré-definidos pela opção Polar 
spacing e pela aba Polar Tracking. 
Polar Tracking É o snap que funciona com ângulos pré-
definidos na opção Polar Angle Settings. Pode-se ligar o 
Polar snap pressionando a tecla F10 ou clicando na 
palavra polar na barra de status. Para controlar como o 
Polar Snap trabalha, modifica-se principalmente a opção 
Polar Angle Settings, selecionando o ângulo desejado ou 
adicionando novos ângulos. 
Object Snap  Permite travar as várias opções de 
Snap ao objeto, sendo: 
-Endpoint  Pega o ponto final de uma entidade. 
-Midpoint  Pega o ponto médio (meio) de uma 
entidade. 
-Center  Pega o ponto central de arcos, círculos 

e dunuts. 
-Node  Pega a entidade point. 
-Quadrant  Pega os quadrantes de arcos, círculos e dunuts, sendo, 0°, 90°, 180° e 270°. 
-Intersection Pega a interseção de duas entidades. 
-Extension  Acha a extensão de uma linha. Trabalha em conjunto com o endpoint. 
-Insertion  Pega o ponto de inserção de blocos e texto. 
-Perpendicular Pega o ponto perpendicular em referência a uma reta a partir do último ponto 
marcado na tela. 
-Tangent  Pega um ponto de um arco ou círculo tangente ao último ponto marcado na tela. 
-Nearest  Pega um ponto qualquer em uma entidade. 
-Apparent Int Pega a interseção aparente de duas entidades. 
-Parallel  Desenha linhas paralelas a outras linhas existenstes. 
-Clear all  Desativa todas as configurações do comando de object snap. 

left

r igth isométr icas
elipses

top
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Toolbar Object Snap: 

 
Esta barra de comandos Object Snap (localizada no Standar Toolbar) permite o uso do comando de 
Object Snap sem que fique travado. 

12. Menu format: 
Layer, Color, Linetype e Lineweight Veja na seção níveis de trabalho. 
Text Style   Veja criação e edição de texto. 
Dimension Style   Veja dimensionamento. 
Point Style   Veja na seção anterior em Point no ítem Menu Draw. 
Multiline Style  Permite criar novos estilos de Multiline. 
Point Style  Veja na seção anterior em Point no ítem Menu Draw. 
Multiline Style Permite carregar e mudificar as propriedades de linhas multiplas 
Thicness  Define uma altura de extrusão para linhas, circulos e polinhas, 
Normalmente utilizado para 3D. 

Drawing Limits Cria um limite virtual para desenhar. Neste limite será onde aparecerão as grids. O 
comando pede-se dois pontos (um sendo o canto inferior esquerdo e o outro o canto superior direito 
da tela). Normalmente este limite deverá ser maior que o objeto a ser desenhado. 
 
Units  Controla como o AutoCAD mostra as unidades e ângulos, sendo: 

-Units Define qual será o tipo de unidade a ser utilizada. 
-Angle Define como será a apresentação dos ângulos. 
-Precisão Define a quantidade de casas decimais. 

-Direção  Define como o AutoCAD 
mostra os ângulos. O usual é com o à direita 
(na possição de 3 horas) e o sentido é anti-
horário. 
Somente em casos especiais, como em uso de 

agrimensura, é que se deve modificar como o programa mostra 
os ângulos. depois se deve voltar ao padrão normal. 
 

Rename Permite renomear entidades Blocks, Dimstyle, Layers, Linetype, Text Style, UCS, View, 
Vport. 

13. Níveis de trabalho: 

 No menu OBJECTS PROPERTIES o segundo ícone acessa o comando do quadro de diálogo 
Layer Control para a criação de layers (camadas). Todo o desenho deve-se ser feito em várias 
camadas. Cada camada pode ser utilizada por um tipo de informação do desenho, como camada para 
estrutura, paredes, cotas, símbolos, mobiliário, portas, janelas, detalhes, etc. 
 Quanto mais camadas tiverem no desenho, mais fácil será editá-lo. Em arquitetura uma 
quantidade de camadas em torno de 20 é o usual, mas tem empresas que utilizam mais de 400 
camadas (para vários projetos diferentes, como incêndio, estrutura, elétrico, hidráulico, paisagismo, 
etc.). 
 O uso do recurso de Paper Space e de View Ports permite ter layer específicos para cada 
porta de visualização, podendo deixa-lo visível ou não em cada porta. 
 
 

90°

180° 0°

270°
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 Analisando o quadro de diálogo de layers, temos: 
-New  Cria-se um novo layer 
com o nome de layer1, permitindo 
entrar com um novo nome. 
-Delete Apaga um layer se ele não 
estiver sendo utilizado. 
-Current Faz do layer selecionado o 
layer ativo. 
-Named layer filters Permite 
selecionar que tipo de layer deseja 
visualizar. 
Na parte principal do quadro: 
-Name Exibe o nome do Layer. 
-On  Liga os layer 
selecionados. 
-Lock  Trava os layer 
selecionados 
-Linetype Permite alterar o tipo de 

linha dos layer selecionados 
-Color  Altera a cor da camada 
-Linetype  Altera o tipo de linha da camada 
-Lineweigth Altera a espessura da linha da camada 
-Plot Style Define um estilo de plotagem para a camada 
-Plot  Permite que a camada seja ou não impressa 
-Details  Permite alterar mais detalhes do layer selecionado. 
Quando estiver dentro de um layout, aparecerão mais estas opções: 
- Active Viewports Freez Congela o layer somente das Viewport ativa. 
-New Viewports Freez  Congela o layer somente das novas Viewport. 
 
O comando Layer também pode ser acessado pela linha de comando (digite -layer). Sub comandos 
do comando Layer 

?  Mostra os layers existente 
 Make Cria um novo layer que se torna corrente 
 Set  Muda o layer corrente 
 New  Cria um novo layer, mas não fica corrente 
 ON  Liga um layer 
 OFF  Desliga um layer, mas o computador mantém o seu processamento 
 Color Muda a cor de um layer 

Ltype  Muda o tipo de linha de um layer 
 LWeight Muda a espessura da linha 
 Plot  Configura a camada para que seja ou não impressa 
 Freeze Congela um layer, o computador não processa 
 Thaw Descongela o layer 
 LOck Trava um layer, não permitindo a sua edição. 
 UNlock Destrava o layer. 

14. Entrada de dados: 
 Além do mouse, as informações de coordenadas podem ser passadas ao AutoCAD pelo teclado 
de maneira precisa, informando numericamente como o programa deve agir. Muitas vezes é 
necessário este procedimento, pois o mouse não permitirá que se chegue ao resultado esperado. 



 Unicentro Izabela Hendrix da Igreja Metodista 
Curso de Arquitetura e Urbanismo - Disciplina de Informática Aplicada à Arquitetura 

 
 

 

18 

Coordenadas absolutas: São coordenadas que utilizam informações de x,y,z para a localização de 
um ponto. 
 Ex.: P1=10,9  P2=7,6,3 
Coordenadas relativas: São coordenadas que utilizam as informações relativas a um ponto anterior 
para definir um novo ponto, com o acréscimo de valores para x,y,z. 
 Ex.: @1,0  anda 1 unidade no x e 0 no y 
  @0,1  anda 0 unidade no x e 1 no y 
  @0,-1 anda 0 unidade no x e -1 no y 
Coordenadas polares: São coordenadas que utilizam as informações relativas a um ponto anterior 
para definir um novo ponto, mas  com informações de direção de distância. 
 Ex.: @3<0 anda 3 unidades no x e 0 no y 
  @3<90 anda 0 unidade no x e 3 no y 
  @3<30 anda 2.59 unidades no x e 1.50 no y 

      P2

 h=3   y=1.5
@=P1

x=3∗sen30° = 2.59
y=3∗cos30° = 1.5
obs:   @ é o útimo ponto
         marcado na tela.

30°

 
Também pode-se entrar com os dados relativo a um ponto no AutoCAD R2000 de maneira 

muito simples, bastando marcar o ponto na tela, indicar a direção e a distância numericamente. 
Filters:  Permite filtrar informações das coordenadas, utilizando-os com outras informações, sendo: 
 .x Filtra o valor x de uma coordenada e pede novos valores para yz 
 .y Filtra o valor y de uma coordenada e pede novos valores para xz 
 .z Filtra o valor z de uma coordenada e pede novos valores para xy 
 .xy Filtra os valores xy de uma coordenada e pede um novo valor para z 
 .xz Filtra os valores xz de uma coordenada e pede um novo valor para y 
 .yz Filtra os valores yz de uma coordenada e pede um novo valor para x 

15. Comandos de visualização: 
 O menu VIEW é dedicado à visualização do desenho. Nele localizam-se 
os comandos de visualização mais utilizados no AutoCAD. 
Redraw Força um redesenho da tela, sem provocar uma regeneração. 
Regen Força uma regenereção da tela, mostrando as curvas de arcos e 
círculos como realmente devem aparentar (sem ficar sextavado). 
Zoom Permite aproximar ou afastar de um objeto. 
 
 
Variações do comando Zoom: 
§ Z. Realtime Permite modificar a magnitude de visualização em tempo real com o auxilio do 

mouse. 
§ Z. Previous Volta à tela de zoom anterior. 
§ Z.Window Visualiza uma janela definida sobre o desenho. 
§ Z. Dynamic Faz um controle de visualização dinâmica sobre o desenho, permitindo aproximar 

ou afastar de um local do desenho. Dentro do comando um quadro aparece inicialmente  , 
representa a área do zoom anterior. Com o botão de pick do mouse o X do quadrado muda para 
uma seta  , permitindo aumentar (afastar do desenho) ou diminuir (aproximar do desenho) a área 
de zoom. Move-se o quadrado sobre a área que deseja visualizar e completa o comando com 
enter. A linha tracejada verde representa o limite do desenho, e se o quadrado com X sair desta 
área, aparece uma ampulheta  , que significa que o comando vai forçar uma regeneração no 
desenho. 
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§ Z.Scale  Multiplica a tela atual por uma nova relação de zoom. 
 Ex:zoom  3x aumenta a tela atual 3 vezes. 
 zoom  .3x reduz a tela para 30% da tela atual. 
 zoom  3 aumenta 3 vezes a tela em relação a tela definida pelo limits. 
§ Z. Center Permite fixar um ponto e aplicar o zoom sobre este ponto. 
§ Z. In  Permite aproximar do desenho (fator de escala 2). 
§ Z. Out  Permite afastar do desenho (fator de escala 0.5). 
§ Z. All  Visualiza todo o desenho mais o limite definido pelo comando limits. 
§ Z.Extend Mostra a extensão máxima que o desenho pode ocupar na tela. 
Toolbar Zoom: 

 Parte do ToolBar Standar:  
Pan Realtime Permite arrastar a tela de visualização sobre o desenho, sem modificar a magnitude 
de visualização em tempo real com o auxilio do mouse. O comando pede dois pontos para o 
movimento da tela. 
Pan Point Semelhante ao anterior, só que o comando pede dois pontos para o movimento da tela. 
Pode-se utilizar as Barras de Rolagem (Scroll Bar) para mover a tela de visualização sobre o 
desenho, de mode semelhante ao caomando Pan. 
Comandos transparentes Pode-se utilizar os comandos zoom e pan dentro de outros comandos, 
bastando colocar um apostrofo (‘) na frente do comando. Acessando o comando pelo menu 
pull-down, o comando já é transparente. Alguns outros comandos também são transparentes. 

16. Processos de seleção: 
 São processos para selecionar uma ou um grupo de entidades para aplicar-lhe um comando 
sobre estas entidades. 
Single Seleciona uma entidade de cada vez com o pick box.. 
Crossing Seleciona as entidades que o retângulo tracejado (crossing) de seleção estiver 

contendo ou passando sobre elas. 
Window Seleciona as entidades que estiverem totalmente dentro do retângulo contínuo 

(window) de seleção. 
Auto Abre-se o retângulo de seleção automático, para esquerda o retângulo é de crossing e 

para direita é de window. 
Box Seleciona os objetos através de um retangulo, por dois pointos. 
CP Crossing-Poligon. Seleciona-se por crossing através de um polígono. 
WP Window-Poligon. Seleciona-se por window através de um polígono. 
Last Seleciona a última entidade desenhada na tela. 
Fence Seleciona as entidades por uma linha de crossing (cerca). 
All Seleciona todas as entidades da tela que não estão em um layer travado. 
Group Seleciona todas as entidades de um determinado grupo. 
Remove Remove do grupo de seleção as entidades selecionadas. 
Add Sai da opção remove e volta adicionar entidades ao grupo de seleção. 
Undo-U Retira do grupo de seleção a última entidade selecionada. 
Previous Pega o grupo anterior de entidades selecionadas. Normalmente um grupo criado pelo 

comando select. 
Filters Comando de seleção mais complexo que o comando Qselect, permitindo a escolha da 

entidade ou características da entidade a ser selecionada.  
Digite na linha de comando: Filter. 
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ponto de inserção 

17. Processos de edição por grips: 
 No processo de edição normal 
do AutoCAD, escolhe-se um comando 
de edição (ex.: move = verbo, ação) e 
aplica-se sobre uma entidade (ex.: 
linha = nome) 
-Comando usa: verbo-nome (ação-
entidade) 
 Quando seleciona um objeto 
sem nenhum comando na linha de 
comandos, acendem-se os grips de 
cor azul nas entidades selecionadas. 
-Grips usa: Nome-verbo 
(entidade-ação) 
 Estando os grips de cor azul, 

qualquer comando de edição pode ser aplicado sobre as entidades selecionadas, sem ter que 
seleciona-las novamente. 
 Quando um desses grips é selecionado, ele fica de cor vermelha. Estando os grips vermelhos, 
cinco comandos estão disponíveis, sendo: stretch, move, scale, rotate e mirror. Também se pode 
utilizar a opção reference dentro de cada comando, modificando o ponto de atuação (base point) do 
comando sobre os objetos. 

O modo como os grips trabalham pode ser alterado pelo quadro de diálogo Grips através do 
menu Tools → Options→ Selection. 

18. Blocos: 
 A manipulação de blocos é uma das ferramentas mais poderosa 
do AutoCAD, permitindo a construção de bibliotecas de desenhos 
padrões para posterior utilização. Os blocos nada mais são que 
simples desenhos feitos normalmente no editor do AutoCAD. Eles 
devem ser salvos no disco rígido (HD) para posterior utilização. Um 
ponto importante a se observar na construção dos blocos é em relação 
ao seu ponto de inserção. Também se deve considerar o layer das 
entidades. Se for um bloco de símbolo que possa ser utilizado em 
qualquer camada (layer), deve-se faze-lo no layer 0, e quando 
inserido no desenho, este assumirá o layer corrente na inserção. 

 
Bmake Este comando cria uma entidade “bloco” com as 

entidades selecionadas. Este bloco criado existe somente no 
desenho em edição Ex.: Para fazer o bloco de uma porta de 80 
cm, desenhe uma polilinha fechada e um arco. Entre com o 
comando Bmake e aparecerá o quadro de diálogo ao lado. De 
um nome ao bloco, por exemplo P-80, selecione o ponto de 
base, como indicado no desenho ao lado, este será o ponto de 
inserção do bloco, quando você utiliza-lo. Selecione os objetos 

que compõe o bloco, e click no 
OK. O seu bloco está pronto, mas 
lembre-se que ele existe somente 
neste seu desenho que esta sendo 
editado. 
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Wblock Entre com este comando no prompt para criar um bloco e grava-lo no H.D como um 
desenho DWG. O bloco criado com o comando  bmake ou block também pode ser gravado com o 
comando wblock. O quadro de diálogo do Wblock e semelhante ao do Mblock, só que permite gravar 
o seu bloco no disco rígido (HD). Note que se você fez um bloco com o comando Mblock, selecione 
em Source a opção Block e escolha o bloco existente que você deseja gravar em disco. 
 

 Insert block (ddinsert) Este comando insere no 
desenho os blocos existentes no desenho ou no disco 
rígido. Permite ainda a mudança de escalas no x, y, z e 
rotação. Selecione todas as três opções Specify on screen, 
senão o programa vai inserir o bloco no ponto, escala e 
rotação especificado dentro do quadro de diálogo. 
Também pode explodir um bloco, desagrupando suas 
entidades, durante ou depois de sua inserção no desenho. 
 

É importante saber como utilizar a rotação e valores de inserção negativos. Veja o exemplo com uma 
porta de 80 cm: 

x=1
y=1

x=1
y=-1

x=-1
y=1

x=-1
y=-1

 

 0° 

270° 

90° 

180° 
x=1 e y=1 

 

90°

0°

180°

270°
x=1 e y=-1

 
Redefinição de blocos: É possível redefinir 
um bloco no desenho, refazendo o bloco com 
o comando Bmake, ou inserindo um novo 
bloco com o comando insert block e 

respondondo sim para o prompt de redefinição. 
Base  Define ou altera o ponto de inserção de um bloco. 
Group Localizado no menu Tools→ Object Group, este comando 
é muito semelhante ao comando Block, o comando Group cria uma 
seleção de objetos, permitindo manipula-los muito facilmente. Veja o 
quadro de diálogo ao lado. 

19. Atributos: 
 São blocos especiais, constituídos de um ou mais 
textos e desenhos. Estes textos podem ser preenchidos 
durante a inserção do bloco. Os atributos também permitem 
a extração de informações do AutoCAD para um programa 
de banco de dados, já sendo este tópico parte de um curso 
mais avançado.  
 

No quadro de diálogo, define o modo de apresentação 
do atributo, o rótulo (tag), a pergunta (prompt) que o bloco 
lhe fará quando inserido e o valor de preenchimento 
(value) do campo quando inserido. O Ponto de inserção é o 
lugar onde o texto será localizado dentro do bloco. As 

opções de texto referem-se à altura de letras, fontes e justificativa. Lembre-se que quando faz um 
bloco de simbologia, a altura do texto deverá estar na escala de 1/1, ou seja, um texto na régua 80, 
terá 0,2 cm. 

O comando está localizado no menu : Draw→Block→Define.Attributes. 
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Ex.: Construção de um bloco de nível: 
 

        NIVEL
        COMODO

TAG: NIVEL
PROMPT: Nivel do Comodo:
DEFAULT: 0,00m
TAG: COMODO
PROMPT: Nome do Comodo:
DEFAULT: SALA  

 
Exercício para treinar: 
Fazer o bloco com atributo chamado “PL.DWG”: 

3 1

4 2

PLANTA

ESCALA

diâmetro=1.2
cm

D01
A01

 
 Solução: Desenha-se normalmente a parte gráfica do bloco na unidade real de medida do 
desenho (se você desenha em centímetros o bloco terá 1,2 unidades de diâmetro, correspondente a 
1,2 cm). Depois se escrevem os atributos. Quando for executar o Wblock, selecione todos os objetos 
e por fim os textos de atributos na seqüência em que serão utilizados quando inseridos. 
 
 Quadro com dicas para a execução deste bloco (guie pelos números do desenho): 
 

 1 2 3 4 
TAG TITULO ESCALA DET PRANCHA 

PROMPT Titulo do desenho: Escala do Desenho: N° do detalhe: N° da prancha: 
DEFAULT planta tipo escala 1/50 - - 

LAYER 0 0 0 0 
COR 12 12 bylayer bylayer 

REGUA CL175-0,4cm CL175-0,4cm CL80-0,2cm CL80-0,2cm 
JUSTIFICAR left left midpoint midpoint 

 

20. Controle de escala dos blocos: 
 Os blocos de vasos sanitários, pias, automóveis, etc., se forem criados em metros ou em 
centímetros, devem obedecer aos seguintes valores de correção quando forem inseridos no desenho: 
 

DESENHO BLOCO ESCALA DO 
BLOCO (A) 

m m 1 
m cm .01 
cm cm 1 
cm m 100 
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 Os blocos especiais de anotação, símbolos, níveis, etc., se forem criados em metros ou em 
centímetros, devem obedecer aos seguintes valores de correção quando forem inseridos no desenho 
(exemplos para escalas de 1/100 e 1/50): 
 

DESENHO BLOCO ESCALA DO 
DESENHO (B) 

ESCALA DO 
BLOCO (C) 

m m 1/100 100 
  1/50 50 

m cm 1/100 1 
  1/50 .5 

cm cm 1/100 100 
  1/50 50 

cm m 1/100 10.000 
  1/50 5.000 

Onde: C=A∗B 
Ou seja: A Nova escala do bloco (C) = Escala do bloco (A) x Escala do desenho (B) 

21. Dimensionamento:  

 
Novos comandos de dimensionamento foram acrescentados ao R2000, sendo: 

DimLinear Executa um dimensionamento linear, podendo ser horizontal, vertical 
ou alinhado a dois pontos. 

DimRotated Permite fazer um dimensionamento rotacionado. Primeiro indica o 
ângulo de inclinação da cota, e depois faz o dimensionamento. 

DimOrdinate Fornece os valores de X ou de Y em relação ao ponto cotado. 
DimRadius Dimensiona o raio de arcos e círculos com o símbolo R. 
DimDiameter Dimensiona o diâmetro de arcos e círculos com o símbolo ∅. 
DimAngular Dimensiona ângulos. 
DimBaseline  Faz as medidas a partir de um ponto de base. Normalmente utilizado 

para desenho mecânico. 
DimContinue Permite continuar os dimensionamentos DimLinear, DimAligned, 

DimOrdinate e DimBaseline.  
DimLeader Coloca linha e seta com texto explicativo, utilizando o Multitext. 

Tolerance Cria anotações de tolerância. 
DimCenter  Marca o centro de arcos e círculos com uma cruz (+). 
DimEdit-Home Força o texto da cota a voltar ao seu local original. 
DimEdit-New Muda o texto de uma cota para um outro valor desejado. Para retornar ao texto 

original, entra com um texto nulo (tecla enter) e seleciona as cotas. 
DimEdit-Rotate Rotaciona o texto da cota.  
DimEdit-Oblique Posiciona o texto de forma inclinada. 
Dim→→Updade Força as cotas antigas a mudarem para o estilo de dimensionamento corrente. 
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Dimensiom Style Abre o quadro de configuração de dimensionamento. Neste quadro várias 
configurações deverão ser ajustadas para um perfeito dimensionamento. Na realidade, este quadro 
modifica as variáveis de dimensionamento (Dimvar) que mantém controle sobre as cotas. 
 Se você utiliza um protótipo Template já configurado com um estilo de dimensionamento, e 
deseja criar mais um novo estilo, basta dar um click no botão New e especificar um novo nome para 
este novo estilo (Ex: base-50) e será criado como uma cópia identica do estilo existente. Para 
adaptar este estilo para a nova escala de trabalho, click no botão Modify e click na aba Fit. No 
campo Use overall scale of, mude o valor para a sua escala (no nosso exemplo = 50). 
 Os quadros de diálogo de dimensionamento, são muito complexos. Para estuda-los melhor, 
procure informação no Help on line do AutoCAD. 

No AutoCAD 2000 ainda existe o prompt especial de dimensionamento (DIM:) para manter 
compatibilidade com as versões anteriores. Para entrar neste prompt digite Dim. Para sair deste 
prompt, digita-se Exit ou Crtl+C  Ctr+C. 

22. Paper space e model space: 
 Até agora somente tem-se desenhado no Model Space, ou seja no espaço do 
modelo. Este espaço tem um ícone com duas setas representando o X e Y com um W no 
meio, que indica o WCS, ou World Cordinate Sistem - Sistema de Coordenadas Global, 
normalmente utilizada para desenhos em duas e três dimensões. 
 
 Pode-se criar vários Layouts para a visualização e organização do desenho a ser 
impreso, com ele é possível criar várias portas de visualização do modelo que está no 
Model Space. Com estas portas, pode-se controlar a escala e layers a ser visualizado. 
Quando se trabalha com apenas uma escala no desenho, é preferível utilizar somente o 

Model Space para desenhar, mas com várias escalas a opção mais simples é o uso do Paper Space. 
Verifique mais adiante o processo de impressão para as duas opções. Quando se está na opção 
Layout, o ícone do WCS transforma-se num esquadro. 
 

  O comando Layout acessado pela barra de 
Navegação, permite alternar entre o Model Space e os Layouts existentes.  
 
 Estando no espaço do modelo e dando um click no botão Model  ,você irá para o 
Layout e o comando de impressão será acionado. Pode-se cancelar o quadro de diálogo de 
impressão.  Agora o comando Model existente na barra de Status permite alternar entre o Model 
Space  e Paper Space  . Note que estando no dentro da opção Layout e acionando o 
botão Paper você acessa a porta de visualização.  (nota: dentro da opção Paper  pode-se trabalhar 
na edição do modelo, mas não é usual – Normalmente entra nesta opção somente para o uso do Pan e 
do Zoom XP).  
 
 Pode-se criar novos Layouts utilizando o Wizards disponível para esta função.  
(menu Tools→→Wizards→→Create layout) 
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Para criar novas portas de visualização dentro 
dos novos layouts é necessário estar dentro da 
opção Paper . Vá ao menu View→→Floating 
Viewports→→Viewport 1 e crie as suas novas portas 
de visualização. Estas portas podem ser movidas, 
copiadas, apagadas ou editadas pelos grips, de 
modo  a serem melhor diagramadas dentro do 
formato de desenho. As portas podem ser de 
formato retangular, circular ou irregular. Deve-se 
criar estas portas dentro de um layer específico 
(por exemplo VP), de modo que possa ser 
congelado antes da impressão. 

 
Fator corretivo de escala para o zoom: 

Após a criação das portas de visualização, deve-se corrigir a escala que cada desenho é apresentado 
dentro de cada. Vá a opção Model  e selecione a porta desejada com um click. Agora execute 
o comando Zoom digitando no teclado (Z) e complete  com a escala desejada (e mais XP). 
 

-Para  uma escala de: 
1 / 50 →   utiliza-se o zoom  = 1/50 xp 
1 / 100 →   utiliza-se o zoom  = 1/100 xp 
1 / 331/3 →   utiliza-se o zoom  = 0.03 xp  (onde  0.03 = 1/331/3). 
2 / 1  →   utiliza-se o zoom  = 2 xp 
 

Atenção: O formato quandro inserido no Lyaout, deverá Ter escala =1. 
§ Se você desenha em unidade de metro, o formato de papel deve ser desenhado em metros. 

Portanto um formato A-1 inserido no Layout terá  0.84x0.594 unidades  
§ Se você desenha em unidade de centímetro, o formato de papel deve ser desenhado em 

centímetros. Portanto um formato A-1 inserido no Layout terá  84x59.4 unidades  
§ Ainda é possível criar e congelar layers específicos para cada porta de visualização, de modo 

que o mesmo desenho visualizado por duas portas diferentes, pode ter informações visíveis 
apenas nas portas desejadas, para isso, vá ao comando de Layer. 

23. Imprimindo um desenho: 
 Inicialmente, estando no Paper Space, congele o layer das portas de visualização. Verifique e 
modifique o valor do Ltscale. Se voce estiver imprimindo no Model ou Layout, siga a regra abaixo: 
 

 Escala do 
 desenho 

Trabalhando no 
Model 

Trabalhando no 
Layout 

Trabalhando Escala 1 / 50 Ltscale = 50  
em Escala 1 / 100 Ltscale = 100 Ltscale=1 

centimetros Escala 1 / 500 Ltscale = 500  
Trabalhando Escala 1 / 50 Ltscale = 0.5  

em Escala 1 / 100 Ltscale = 1 Ltscale=0.01 
metros Escala 1 / 500 Ltscale = 5  

 

 Preview de impressão: Execute Preview de impressão antes de imprimir. Faça-o também 
dentro do comando Print 
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 Dentro do comando print: 
O comando Prrint do AutoCAD 2002 está muito 

mais completo (e complexo) do que as versões 
anteriores do programa. Vale a pena passar pelos Helps 
em forma de vídeo disponível no programa. Estes helps 
dão uma visão clara dos novos comandos e seus usos. 
Sempre em caso de duvidas, consulte-os. 

 
Como imprimir no AutoCAD 2002: 
 

§ Primeiro verifique ou modifique o dispositivo de 
impressão (impressora ou plotter). Se não tiver o 
dispositivo de impressão apropriado, cancele o 
comando e vá ao menu Tolls→Options→Plotting, e 
no botão Add or Configure Plotters  para instalar 
uma nova impressora. 

§ Vá ao menu Files e chame o comando Plot, que 
abrirá o quadro de diálogo ao lado. 

§ Verifique ou altere as penas e suas correspondências 
com as cores das entidades no AutoCAD. Isto só 
será possível dependendo do dispositivo de 
impressão instalado. 

§ Na opção Window, selecione os limites do formato a 
ser plotado. Se for imprimir uma parte apenas do 

desenho, tente manter a janela de window mais próxima da 
proporção do papel a ser impresso. 

§ Selecione ou crie um novo tamanho de papel a ser plotado. 
Note que o papel a ser impresso não pode ser maior que o 
máximo especificado pelo programa. 

§ Selecione ou altere a rotação do formato a ser plotado. 
§ Defina a escala a ser plotado o desenho, sendo: 
 
 
 
 

 
Está-se trabalhando com o formato no Paper Space e desenho no Model Space: 
 

§ Exemplos com desenhos na unidade de Metros: 
ESCALA →→  PLOTTED mm = DRAWING UNITS  

1/10 → 1000 = 1     
1/100 → 1000 = 1       SEMPRE 
1/500 → 1000 = 1     

 
§ Exemplos com desenhos na unidade de Centímetros: 

ESCALA →→  PLOTTED mm = DRAWING UNITS  
1/10 → 10 = 1     
1/100 → 10 = 1       SEMPRE 
1/500 → 10 = 1     
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Está-se trabalhando com o desenho no Model Space somente, e com o formato de desenho também 
no Model Space: 
 

§ Exemplos com desenhos na unidade de Metros: 
ESCALA →→  PLOTTED mm = DRAWING UNITS  

1/10 → 1000 = 10     
1/100 → 1000 = 100     VARIÁVEL 
1/500 → 1000 = 500     

 
§ Exemplos com desenhos na unidade de Centímetros: 

ESCALA →→  PLOTTED mm = DRAWING UNITS  
1/10 → 10 = 10     
1/100 → 10 = 100     VARIÁVEL 
1/500 → 10 = 500     

 
Preview Após todos os itens verificados, faça uma visão prévia do desenho para evitar erros na 
plotagem. 
 
Na opção File Name... pode-se aceitar o nome default ou especificar um outro nome para o arquivo 
de plotagem (se a opção de Plot to File estiver ligada). Leva-se o arquivo de plotagem (.PLT) para 
um Bureal de Serviço e está pronto o desenho. (deve-se configurar um plotter do mesmo tipo 
existente no Bureal). 

 
Os plotters a jato de tinta tem-se 255 cores de penas diferentes, com um número infinito de 
espessura de traço para cada cor, sendo praticamente ilimitado as possibilidades de configurações 
para cores e espessuras de traço destinado a cada uma das 255 cores do AutoCAD. Cada cor do 
plotter representa uma caneta, sendo portanto 255 canetas em 255 cores diferentes. Normalmente 
utiliza-se a caneta 7 (sete)  para desenhar as linhas pretas, configurando todas as cores do AutoCAD 
para desenhar com a pena 7, mas com cada cor no AutoCAD com espessuras diferentes de traços. 
Quando Imprimir escolha no campo Plot Style Table a opção Grayscale. Você pode configurar tanto 
impressoras ou plotters dentro do comando de impressão. 

24. Outros comandos: 
 Existem vários outros comandos no AutoCAD que também merecem um pouco mais de atenção. 
Estes comandos já pertencem a um nível mais elevado de estudo, portanto não entraremos em 
maiores detalhes sobre os seus usos. 
 
Inquiry Permite verificações no desenho, com distância , área e a coordenadas de um ponto (id). 

 
Xref  Permite trabalhar com arquivos  externos de desenhos referenciados (um pouco parecido 
com o Bloco na visualização, mas completamente diferente no conceito). Ë um recurso interessante 
para projetos complexos, onde por exemplo, a estrutura do edif’ício poderia ser um desenho 
referenciado e não um Bloco inserido dentro do desenho. Se o calculista modifica a sua estrutura, 
todos os desenhos que possuírem aquele Xref também modificarão. 
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Preferences Faz o ajuste do programa com os equipamentos utilizados, ex.: impressora, plotter, 
monitor, mouse, mesa digitalizadora, etc. Quando é instalado o AutoCAD, este assume as 
configurações do Windows. Para acrescentar um novo plotter ou impressora, deve-se refazer a 
configuração. 
Menu Tools: 

 UCS   Carrega o menu de Sistema de Coordenadas. 
Menu Help: 

 AutoCAD Help  Mostra o Help online do AutoCAD 
Quick Tour  Carrega programa de multimídia descrevendo conceitos básicos. 
What's New  Carrega programa de multimídia descrevendo novas características. 
Learning Assistance Carrega programa de multimídia para treinamento interativo. 
Connect to Internet Carrega o Browser para a Internet. 
About AutoCAD... Mostra Informações Sobre o AutoCAD. 
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